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Revision history

Date Version Description
May 2020 1.3 Updated:

e Firmware on page 13 by adding links to relevant
documentation

Replaced:

¢ Firmware update chapter with Programming Nordic
Thingy:91 on page 13
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¢ Kit content diagram and added a short description
e Getting started on page 10

e Connecting LTE Link Monitor on page 12
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Added the different ways to obtain firmware images for
updating firmware, and operating modes:

e Firmware on page 13

Updated different firmware update methods and added new
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August 2019 1.0 First release
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Introduction

The Nordic Thingy:91TM is a battery-operated prototyping platform for cellular 10T, certified for global
operation. It is ideal for rapid development of prototypes for cellular loT systems and is especially suited
for asset tracking applications and environmental monitoring.

Nordic Thingy:91 includes sensors that gather data about its own movements and the surrounding
environment. Temperature, humidity, air quality, air pressure, color, and light data can easily be extracted
for local or remote analysis. For input, the Nordic Thingy:91 offers a user-programmable button. Visual
output is achieved with RGB indicator LEDs, while a buzzer can provide audible output. The standard
application firmware on Nordic Thingy:91 extracts the data from the different sensors and relays it
securely to the nRF Connect for Cloud, where it is displayed in a user-friendly interface.

The firmware supports concurrent operation with LTE Link Monitor, a tool providing an AT command
interface, enabling link and network testing. LTE Link Monitor is an application, which is implemented as
part of the nRF Connect for Desktop application. The firmware has been developed using the nRF Connect
Software Development Kit (SDK). It is open source and can be leveraged and modified to suit your specific
needs. The firmware can be updated and debugged by using an external programmer/debug probe, for
example nRF9160 Development Kit (DK) or J-Link device supporting Arm Cortex-M33.

Nordic Thingy:91 integrates the nRF9160 System in Package (SiP)l, supporting LTE-M, NB-loT and Global
Positioning System (GPS), and the nRF52840 System on Chip (SoC), supporting Bluetooth® Low Energy and
Near Field Communication (NFC) passive tag.

Note: LTE-M or LTE NB-loT can operate simultaneously with Bluetooth LE.

Source code for firmware, hardware layout, and schematics are all available on our web site
www.nordicsemi.com.

Nordic Thingy:91 has an antenna supporting GPS, LTE-M, and NB-loT that enables it to support a global
range of LTE bands. It has two antennas connected to the nRF52840: a 2.4 GHz antenna for Bluetooth LE
and an NFC passive tag antenna. To connect to cellular network out of the box, Nordic Thingy:91 has a
nano/4FF SIM card slot and is bundled with a SIM card from iBasis that comes preloaded with 10 MB.

NFC in Nordic Thingy:91 operates as a passive tag (e.g. it does not feature a reader function). Nordic
Thingy:91 may use this tag function for the Out of Band pairing feature as described in the Bluetooth Core
Specification.

A 1400 mAh rechargeable Li-Po battery is also part of this prototyping platform giving a smooth transition
into prototype field-testing.

Key features of Nordic Thingy:91

® 700-960 MHz + 1710-2200 MHz LTE band supportz. The following bands, based on geographic regions,
are used:

e USA-2,4,12,and 13
e EU-3,8,20,and 28
e Certifications: CE, FCC
e LTE-M/NB-lIoT/GPS, Bluetooth LE and NFC passive tag antennas

1 The nRF9160 SiP is certified for USA bands 2,4,5,12,13, 14, 17, 25, 26, and 66. However, Nordic
Thingy:91 operates and is only certified for USA bands 2, 4, 12, and 13. The Nordic Thingy:91
firmware is written and documented to only use this subset of USA bands.

2 The application currently enables the following frequency bands: 2, 3, 4, 8, 12, 13, 20, and 28.
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https://www.nordicsemi.com

Introduction

Nano/4FF Subscriber Identity Module (SIM) card slot
User-programmable button and RGB LEDs
Environmental sensor for temperature, humidity, air quality, and air pressure
Color and light sensor

Low-power and high-G accelerometer

Buzzer

4 x N-MOS transistor for external DC motors or LEDs
Rechargeable Li-Po battery with 1400 mAh capacity
Charging through Universal Serial Bus (USB)

PC connection through USB

Normal operating temperature range: 5°C ~ 35°C

nRF9160

Multimode LTE-M/NB-loT modem

e GCF certified for global operation

e 23 dBm output power

e GPS

e Power saving features: DRX, eDRX, PSM

e Coverage enhancement modes

¢ Single pin 50 Q antenna interface

e Universal Integrated Circuit Card (UICC) interface
Application processor

e 64 MHz Arm® Cortex®-M33 CPU

e Arm TrustZone® for trusted execution

e Arm CryptoCell 310 for application layer security
e 1 MB flash and 256 kB RAM

e 4 xSPI/UART/TWI, PDM, 12S, PWM, ADC

nRF52840 WLCSP

Bluetooth LE and NFC passive tag support
64 MHz Arm Cortex-M4F CPU

1 MB flash and 256 kB RAM

usB

Environmental Protection

Please recycle where facilities exist. Check with your local authority or
retailer for recycling advice.

Waste electrical products should not be disposed of with household waste.

U =snmm

The battery in this product cannot be easily replaced by users themselves. Batteries should be removed
only by qualified professionals due to safety concerns.

4418 1336v1.3 6
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2 Related documentation

In addition to the information in this document, you may need to consult other Nordic documents.

¢ nRF9160 Product Specification

e nRF52840 Product Specification
¢ nRF9160 DK

¢ nRF52840 DK

e nRF9160 Errata

e nRF52840 Errata

¢ nRF Connect SDK documentation
¢ nRF Connect for Cloud

¢ nRF Connect LTE Link Monitor

e nRF Connect Programmer

¢ nRF91 AT Commands Reference Guide
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https://infocenter.nordicsemi.com/topic/ps_nrf9160/nRF9160_html5_keyfeatures.html
https://infocenter.nordicsemi.com/topic/ps_nrf52840/keyfeatures_html5.html
https://infocenter.nordicsemi.com/topic/ug_nrf91_dk/UG/nrf91_DK/intro.html
https://infocenter.nordicsemi.com/topic/ug_nrf52840_dk/UG/nrf52840_DK/intro.html
https://infocenter.nordicsemi.com/topic/struct_nrf91/struct/nrf9160_errata.html
https://infocenter.nordicsemi.com/topic/struct_nrf52/struct/nrf52840_errata.html
http://developer.nordicsemi.com/nRF_Connect_SDK/doc/latest/nrf/index.html
https://nrfcloud.com
https://infocenter.nordicsemi.com/topic/ug_link_monitor/UG/link_monitor/lm_intro.html
https://infocenter.nordicsemi.com/topic/ug_nc_programmer/UG/nrf_connect_programmer/ncp_introduction.html
https://infocenter.nordicsemi.com/topic/ref_at_commands/REF/at_commands/intro.html

3 Kit content

The Nordic Thingy:91 kit consists of hardware and access to software components, hardware design files,
applications, and documentation.

-«

NORDIC
THINGY:9I

Prototyping Platform

N
NORDIC

Nordic Thingy:91 E

m (3]

(2]

S FOR THINGS

Figure 1: Nordic Thingy:91 hardware content

The Nordic Thingy:91 kit contains the following:

¢ Nordic Thingy:91 device with a rubber enclosure serving as a protective cover
e An eSIM (SIM card) from iBASIS supported by the nano/4FF SIM card slot of Nordic Thingy:91
¢ Aninformation leaflet

WARNING - Power adapter is not included in the kit.3

3.1 Downloadable content

The Nordic Thingy:91 prototyping platform includes firmware source code, documentation, hardware
schematics, and layout files.

Firmware

e Application firmware for Nordic Thingy:91

3 Power supply adapter is not included in the safety certification test report, see separate test report
according to IEC 62368. The power supply adapter you will use shall meet PS1 requirements.
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https://www.nordicsemi.com/Software-and-Tools/Prototyping-platforms/Nordic-Thingy-91/Download#infotabs

Kit content

¢ Precompiled HEX files

¢ nRF52840 USB to UART bridge
¢ nRF9160 modem firmware
e nRF Connect SDK

PC tools

¢ nRF Connect LTE Link Monitor
e Segger Embedded Studio
e nRF Connect Programmer

Web applications

e nRF Connect for Cloud

Hardware files

The hardware files can be downloaded from the Nordic Thingy:91 product page.

The zip file and its subdirectories contain the hardware design files for the Nordic Thingy:91. The hardware

files for the circuit board are available in the following folder in the hardware files zip package:
\Thingy91l - Hardware files x x x\PCA20035-Thingy91 Board x x X

In this folder, you can find the following hardware design files:

e Altium Designer files

¢ Schematics and PCB layout files in PDF format

e Bill of materials
e Production files:

e Drill files

e Assembly drawings
e Gerber files

¢ Pick-and-place files

4418 _1336v1.3
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https://www.nordicsemi.com/Products/Low-power-cellular-IoT/nRF9160/Download#infotabs
https://www.nordicsemi.com/Software-and-Tools/Software/nRF-Connect-SDK
https://infocenter.nordicsemi.com/topic/ug_link_monitor/UG/link_monitor/lm_intro.html
https://www.nordicsemi.com/Software-and-tools/Development-Tools/Segger-Embedded-Studio
https://infocenter.nordicsemi.com/topic/ug_nc_programmer/UG/nrf_connect_programmer/ncp_introduction.html
https://nrfcloud.com
https://www.nordicsemi.com/Software-and-Tools/Prototyping-platforms/Nordic-Thingy-91

Getting started

Setting up Nordic Thingy:91 requires completing the following steps.
Before you start:

e Unpack Nordic Thingy:91.
¢ Make sure to update the Nordic Thingy:91 firmware as explained in Programming Nordic Thingy:91.
¢ Make sure you have an nRF Connect for Cloud account and sign in to nRF Connect for Cloud.

Once you are signed in, perform the following steps.

1. Add new LTE device.

¢ NRF Cloud

_I_

(=]
ao

DASHEQARD

Add Bluetooth Gati

Add a gateway 1o oo

to the internet
Figure 2: Adding new LTE device in nRF Cloud

2. Verify and activate the SIM card.

Input SIM ICCID and Personal Unblocking Key (PUK) from the SIM card, and add personal information.

e NN -rue
——

esIiMm
123456789
123456789,

A012

_/
Figure 3: Placement of PUK and SIM ICCID on the SIM card

3. Gently remove the rubber overlay to reveal the power switch and the top of Nordic Thingy:91. Insert
the SIM card.
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https://infocenter.nordicsemi.com/topic/ug_nc_programmer/UG/nrf_connect_programmer/ncp_programming_thingy91.html
https://nrfcloud.com

Getting started

Insert
SIM

‘ NN
spo Of =
Egg% L] :D mE
Jdook™—=" GPS
20 O] 8,
i ==
L+ eunOg n
o B ol |
S©§D1v3 o £
oo -
h@anFSZ Nelel
S%“nRFsl ©©
5 bo d B m
Q0 Q9 nmg itk

Figure 4: Inserting the SIM card

Multi-function button (SW3)

nRF52840 recovery button (SW4)

4. Once the SIM card is inserted, power on Nordic Thingy:91. You will find the power switch next to the
micro-USB port.

=

T TOF 7
\ / !\E'ML.QJN(DW& S0 o " OO it
a1 IN our QBNB—E—E-NN

Power switch (SW1)

Figure 5: Nordic Thingy:91 Power switch

Wait for yellow breathing in the indicator LED. If the LED does not turn yellow, check Operating states
of Nordic Thingy:91 to determine the present state of Nordic Thingy:91.

5. Associate the Nordic Thingy:91 to your user account.

Enter the IMEI and PIN information that is found on the sticker on the Nordic Thingy:91 PCB. Wait for

blue breathing which means that your Nordic Thingy:91 is associated and connected.

4418_1336v1.3

PIN/HWID

Add LTE Device

To connect your device, enter the IMEIl and PIN or HWID

Have an old devkit without a PIN?

Figure 6: Associating Nordic Thingy:91 to nRF Cloud
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https://developer.nordicsemi.com/nRF_Connect_SDK/doc/latest/nrf/applications/asset_tracker/README.html#thingy91-operating-states
https://developer.nordicsemi.com/nRF_Connect_SDK/doc/latest/nrf/applications/asset_tracker/README.html#thingy91-operating-states

Getting started

6.

For optional activation of GPS, go outdoors and press the SW3 button for a minimum of 10 seconds
until the indicator LED begins breathing purple.

¢ Purple breathing: GPS is active and searching
e Green breathing: GPS has fix

Wait for green breathing in the indicator LED which indicates that your Nordic Thingy:91 has GPS fix.

Check that the position data and the environment sensor data are sent to nRF Connect for Cloud.

4.1 Connecting LTE Link Monitor

To get debug output and to send AT commands directly to the modem, you can connect to the Nordic
Thingy:91 using nRF Connect LTE Link Monitor.

Before you begin, install and open nRF Connect for Desktop. To download the latest version, go to nRF
Connect for Desktop. For instructions, see nRF Connect LTE Link Monitor.

To connect to the Nordic Thingy:91 using LTE Link Monitor, perform the following steps.
1. Install and launch LTE Link Monitor.

i s W N

Connect your Nordic Thingy:91 to your computer with a USB cable.
Make sure that Nordic Thingy:91 is powered on.
Click Select device and select the device entry from the drop-down list in the LTE Link Monitor.

Verify the connection to the Nordic Thingy:91 modem by sending the command AT to the modem
from the LTE Link Monitor terminal and observing that the modem responds with OK.

All asset tracker debug output shows up in the terminal view, and you can send AT commands to
the modem to try out different settings. For further details on available AT commands, see nRF91 AT
Commands Reference Guide.

4418 1336v1.3 12
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https://www.nordicsemi.com/Software-and-Tools/Development-Tools/nRF-Connect-for-desktop
https://www.nordicsemi.com/Software-and-Tools/Development-Tools/nRF-Connect-for-desktop
https://infocenter.nordicsemi.com/topic/ug_link_monitor/UG/link_monitor/lm_intro.html
https://infocenter.nordicsemi.com/topic/ref_at_commands/REF/at_commands/intro.html
https://infocenter.nordicsemi.com/topic/ref_at_commands/REF/at_commands/intro.html

5

FiIrmware

The firmware of Nordic Thingy:91 has been developed using the nRF Connect SDK. It is open source, and
can be modified according to specific needs.

The asset tracker application firmware, which is pre-loaded in the Nordic Thingy:91, enables the device
to use the environment sensors as described in Environment sensors on page 25, and provides an

option of tracking the device using GPS. The data, along with information about the device, is transmitted
to Nordic Semiconductor's cloud solution, nRF Cloud, where it can be visualized. For more information on
the asset tracker application, see nRF9160 Asset Tracker.

You can find more information on the firmware and the associated features in the Working with Thingy:91
nRF Connect SDK documentation.

5.1 Programming Nordic Thingy:91

You can program the modem and applications on a Nordic Thingy:91 using multiple methods. Applications
can be programmed either on the nRF9160 SiP or on the nRF52840 SoC.

The different ways to program the modem and the applications on a Nordic Thingy:91 are listed below.

¢ Using USB (MCUboot)
e Using an external debug probe

If you are programming applications using USB, you can choose the component to be programmed by
pushing the SW3 or SW4 button of a Nordic Thingy:91 while powering on. This puts the device in serial
recovery mode.

If you are programming applications using an external debug probe, you can use an nRF9160 DK or any J-
Link device supporting Arm Cortex-M33 as the external debug probe. The component to be programmed
is determined by the setting of the SWD selection switch (SW2) of Nordic Thingy:91 to nRF91 or nRF52.

See the following documentation for the detailed procedures to program applications and to program the
modem on a Nordic Thingy:91.

* Programming applications on Nordic Thingy:91
e Programming the Nordic Thingy:91 modem

N

NORDIC"

SEMICONDUCTOR

4418 1336v1.3 13


https://developer.nordicsemi.com/nRF_Connect_SDK/doc/latest/nrf/applications/asset_tracker/README.html#nrf9160-asset-tracker
https://developer.nordicsemi.com/nRF_Connect_SDK/doc/latest/nrf/ug_thingy91.html
https://infocenter.nordicsemi.com/topic/ug_nc_programmer/UG/nrf_connect_programmer/ncp_programming_appln_thingy91.html
https://infocenter.nordicsemi.com/topic/ug_nc_programmer/UG/nrf_connect_programmer/ncp_updating_modem_thingy91_intro.html

6 Hardware description

This chapter focuses on the hardware components of Nordic Thingy:91 with detailed descriptions of the
various hardware blocks that are present on the device.

The sensors available in Nordic Thingy:91 are not calibrated in production. Nordic Semiconductor does
not specify the accuracy of measurements. Users who want to reuse parts of this design to create
measurement devices should conform to documentation of the specific sensors.

6.1 Block diagram

The block diagram represents interactions between hardware components on Nordic Thingy:91.

— Buzzer driver B ]
NMOS
[
transistors
SIM card —— Color sensor
LED driver
sensor
”
3. .
Current
M » <_m -
! nRF9160 A
Antenna
RF switches/ U/
Battery —] Power switch & oy matching —
network

mEmma SWDselect Antenna

L, Current Matching
measurement network

nRF52840

Spare GPIO NFC passive tag
connector antenna
A

17

Debug in

Figure 7: Nordic Thingy:91 hardware block diagram

6.2 Hardware figures

The hardware figures show elements on both sides of the Nordic Thingy:91 PCB.

4418 1336v1.3 14 >
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Hardware description

SIM card slot (J4)—
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Figure 8: Nordic Thingy:91 PCB, top
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Multi-function button (SW3)

—SWD selection switch (SW2)

——Indicator LED (LD3)

—+—Indicator LED (LD2)

7*U7

—U8
—U9

13

—Power switch (SW1)

L@

USB connector (J6)

Figure 9: Nordic Thingy:91 PCB, bottom

6.3 NRF9160

The nRF9160 is the main device of Nordic Thingy:91. It is a compact, highly integrated SiP that makes use
of the latest low-power LTE technology. It has advanced processing capabilities and security features. It

also has the accessibility and flexibility to be used with a wide range of single-device low-power cellular
loT applications.

For more information, see nRF9160 Product Specification.

4418_1336v1.3
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6.3.1 Antenna tuning

To improve antenna efficiency, Nordic Thingy:91 has dynamic antenna tuning.

VDD_GPIO

D—K}—l—” DECO
NSRO620P2T5G

C3
4TuF

L ; P0.08

SCLK

VIO =

nRF9160

MAGPIOO <3
MAGPIO1 i=
MAGPIO2 (==

| _RF I
MMB&130-2600\

ﬂ ANT
9
’ SDATA

A
T9/AING 3

;
POIG/A]
T7/A]
8
PO20/AINT

4.70F

*_nRF91 SWDCLK

SWDCLK i
nRF91 SWD SWDIO «—2RFOT SWDIO
SIM RST
RST =
DET
DE) CLK
SIM CLK.
M 10
1 M _IVS
V8

Figure 10: nRF9160 schematic

UIA
nRF9160-SICA

§1__GPS RF

LTE RF

Different tuning components are used for different frequencies. This is achieved by using tuning

components between two SP8T RF switches. The switches are automatically controlled by the nRF9160
LTE modem and set to the correct state based on the frequency of operation. Six paths are used for LTE
frequency, and one path is used for GPS frequency.

RF_SW3 RF_SW2 RF_SW1 State Band Frequency

0 0 0 RF2 - RFC Not used Not used

0 0 1 RF7 - RFC 13U/D, 28D 746 MHz - 803 MHz

0 1 0 RFS5 - RFC 12U/D, 17U/D, 28U 698 MHz - 748 MHz
1U/D, 2U/D, 3U/D, 4U/D, 1710 MHz - 2200 MHz
25U/D

0 1 1 RF3 - RFC 5D, 20U, 26D 824 MHz - 894 MHz

1 0 0 RF1 - RFC 8U/D 880 MHz - 960 MHz

1 0 1 RF8 - RFC 5U, 20D, 26U 791 MHz - 849 MHz

1 1 0 RF6 - RFC Not used Not used

1 1 1 RF4 - RFC GPS 1574 MHz - 1577 MHz

4418_1336v1.3

Table 1: Antenna tuning bands
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Hardware description
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Figure 11: Antenna tuning circuitry schematic

6.3.2 RF measurements

The LTE signals are propagated through a coaxial connector. This makes it possible to perform conducted
measurements or attach external antennas.

By default, when no cable is attached, the RF signal is routed to the onboard antenna. When connecting
the adapter, the internal switch in the SWF connector will disconnect the onboard antenna and connect
the RF signal from the nRF9160 to the adapter.

The connector is of SWF type (Murata part no. MM8130-2600) with an internal switch. An adapter

is available (Murata part no. MXHS83QE3000) with a standard SMA connection on the other end for
connecting instruments. The adapter is not included in the kit. The insertion loss in the adapter cable is
approximately 0.5—-1 dB.
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" ie;annrsz; " e (OO
P W o0T o y

Q Thingy:91 5 5" 5@‘ [e]@) O
onoff 0 BT P el —

Figure 12: Connecting a spectrum analyzer

6.3.3 GPS

The nRF9160 has a dedicated GPS port to support global navigation, and the same antenna is used for
both LTE and GPS. The GPS signal is RX only, and there is a low-noise amplifier (LNA) that amplifies the
signal before it is fed to the GPS RF port on the nRF9160.

The GPS signals are propagated through a coaxial connector located between the antenna and the

LNA. This makes it possible to attach external antennas. The connector is of SWF type (Murata part no.
MM8130-2600) with an internal switch. An adapter is available (Murata part no. MXHS83QE3000) with a
standard SMA connection on the other end for connecting instruments. The adapter is not included in the
kit. The insertion loss in the adapter cable is approximately 0.5-1 dB.
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Figure 13: External GPS antenna connector

The LNA enable signal is controlled by the logic circuitry. It is enabled only when the antenna tuning
circuitry is set to operate at the GPS frequency band. The LNA makes the GPS receiver more sensitive to
GPS signals and less sensitive to interference from other sources nearby.
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Figure 14: GPS circuit schematic

Note: GPS signals do not usually penetrate ceilings or other structures. For best GPS performance,
Nordic Thingy:91 should be used outside in an open space, far from sources of interference and
other structures that may block the signals.

6.3.4 SIM card

Nordic Thingy:91 is equipped with a nano-S/IM (4FF) card slot.
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SIM

6.4 nRF52840

Figure 15: SIM card schematic
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For USB, Bluetooth, and NFC passive tag connectivity, Nordic Thingy:91 uses a nRF52840 SoC. It is a
powerful, highly flexible, ultra-low power SoC that incorporates a Bluetooth Low Energy radio and a 32-bit

Arm Cortex-M4F CPU.

For more information on the SoC, see nRF52840 Product Specification.
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6.4.1 NFC passive tag

Figure 16: nRF52840 schematic

Nordic Thingy:91 supports an NFC passive tag. NFC-A listen mode operation is supported on the

nRF52840.

The NFC passive tag antenna input is available on connector J5.
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Figure 17: NFC passive tag antenna connector
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The NFC passive tag uses two pins, F1 (NFC1) and E2 (NFC2), to connect the antenna. These pins are
shared with GPIOs (PO .09 and P0.10), and the PROTECT field in the NFCPINS register in UICR defines
the usage of these pins and their protection level against abnormal voltages. The content of the NFCPINS
register is reloaded at every reset.

Note: The NFC passive tag pins are enabled by default.

The NFC passive tag can be disabled and the GPIOs enabled by defining the
CONFIG_NFCT_PINS_AS_GPIOS variable in the project settings. The way of doing this depends on the
Integrated Development Environment (IDE) or toolchain in use.

¢ When using SEGGER Embedded Studio, go to Project > Edit Options > Code > Preprocessor >
Preprocessor Definitions and add the CONFIG_NFCT_PINS_AS_GPIOS variable.

¢ When using Keil, go to Project > Options for Target > C/C++ > Preprocessor Symbols > Define and add
the CONFIG_NFCT_PINS_AS_GPIOS variable.

6.4.2 USB

The Nordic Thingy:91 USB connector is connected to the USB interface of the nRF52840 SoC. This enables
PC communication and battery charging.

6.5 Pin maps

The pin assignments for the nRF9160 SiP and nRF52840 SoC are listed in the pin map tables.

1/0 Label Description
P0.00 SENSE_LED_RED Red color of the color sensor support LED
P0.01 SENSE_LED_GREEN Green color of the color sensor support LED
P0.02 SENSE_LED_BLUE Blue color of the color sensor support LED
P0.03 SCK SPI clock line
P0.04 MOSI SPI master output, slave input data line
P0.05 MISO SPI master input, slave output data line
P0.06 ADXL372_INT1 High-G accelerometer interrupt line
P0.07 ADXL372_CS High-G accelerometer chip select line
4418 1336v1.3 20 N
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1/0 Label Description

P0.08 ADXL362_CS Low-power accelerometer chip select line

P0.09 ADXL362_INT1 Low-power accelerometer interrupt line

P0.10 ADXL362_INT2 Accelerometer interrupt line 2, selectable by solder
bridge

P0.11 SDA I°C data line

P0.12 scL I°C clock line

P0.13 N-MOS_1 Gate of N-MOS transistor externally available

P0.14 N-MOS_2 Gate of N-MOS transistor externally available

P0.15 N-MOS_3 Gate of N-MOS transistor externally available

P0.16 N-MOS_4 Gate of N-MOS transistor externally available

P0.17 ADP_INT PMIC interrupt line

P0.18 MCU_IFO nRF52840 interface

P0.19 MCU_IF1 nRF52840 interface

P0.20 MCU_IF2 nNRF52840 interface

P0.21 MCU_IF3 nNRF52840 interface

P0.22 MCU_IF4 nNRF52840 interface

P0.23 MCU_IF5 nNRF52840 interface

P0.24 MCU_IF6 nNRF52840 interface

P0.25 MCU_IF7 nRF52840 interface

P0.26 BUTTON Button input

P0.27 BH_INT Color sensor interrupt line

P0.28 BUZZER Buzzer PWM signal

P0.29 LIGHTWELL_RED Red color of the lightwell LEDs

P0.30 LIGHTWELL_GREEN Green color of the lightwell LEDs

P0.31 LIGHTWELL_BLUE Blue color of the lightwell LEDs

4418_1336v1.3
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1/0 Label Description

P0.00 XL1 Low frequency crystal

P0.01 XL2 Low frequency crystal

P0.02 N.A. Not used

P0.03 SPARE7 Analog/digital GPIO externally available
P0.04 N.A. Not used

P0.05 SPARE2 Analog/digital GPIO externally available
P0.06 SPARE1 Digital GPIO externally available

P0.07 N.A. Not used

P0.08 N.A. Not used

P0.09 NFC1 NFC passive tag antenna

P0.10 NFC2 NFC passive tag antenna

P0.11 MCU_IFO NRF9160 interface

P0.12 N.A. Not used

P0.13 N.A. Not used

P0.14 IF_SWD_IO nNRF9160 SWD interface data line

P0.15 MCU_IF1 NRF9160 interface

P0.16 N.A. Not used

P0.17 IF_SWD_CTRL nNRF9160 SWD interface control

P0.18 RESET NRF52840 reset line, available on test point
P0.19 MCU_IF6 NRF9160 interface

P0.20 MCU_IF2 nNRF9160 interface

P0.21 MCU_IF3 NRF9160 interface

P0.22 MCU_IF7 nRF9160 interface

P0.23 N.A. Not used

P0.24 N.A. Not used

P0.25 MCU_IF5 NRF9160 interface

P0.26 SPARE3 Digital GPIO externally available

P0.27 SPARE4 Digital GPIO externally available

P0.28 SPARES Digital GPIO externally available

P0.29 N.A. Not used

P0.30 SPARE6 Analog/digital GPIO externally available
P0.31 N.A. Not used

P1.00 MCU_IF4 NRF9160 interface

P1.01 COEX2 nRF9160 COEX interface

4418_1336v1.3
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P1.02 N.A. Not used

P1.03 N.A. Not used

P1.04 COEX1 nNRF9160 COEX interface

P1.05 IF_SWK_CLK nNRF9160 SWD interface clock line
P1.06 N.A. Not used

P1.07 COEXO0 nRF9160 COEX interface

P1.08 SDA I°C data line

P1.09 scL I°C clock line

P1.10 N.A. Not used

P1.11 SPARES8 Digital GPIO externally available
P1.12 N.A. Not used

P1.13 BOOT Boot button

P1.14 N.A. Not used

P1.15 N.A. Not used

6.6 Motion sensors

Table 3: nNRF52840 pin map

Nordic Thingy:91 includes a low-power accelerometer and a high-G accelerometer.
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Figure 18: Low-power and high-G accelerometers schematic

When Nordic Thingy:91 is in low-power sleep mode, any user interaction will be detected by the low-
power accelerometer. The accelerometer has an SPl interface and it can detect motion on three axes. By
default, the INT2 line of the accelerometer is not connected to nRF9160. If you want to use the INT2 line,
solder SB6.

For detecting shocks, Nordic Thingy:91 uses a high-G accelerometer. The accelerometer has an SPI
interface, and it can detect motion on three axes. By default, the INT2 line of the accelerometer is not
connected to nRF9160. If you want to use the INT2 line, solder SB5.
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Figure 19: Low-power accelerometer and high-G accelerometer interrupt line 2 selection
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6.7 Environment sensors

To monitor its surroundings, Nordic Thingy:91 has a multi-sensor chip that contains several sensors for
detecting different environmental properties and a separate color and light sensor.

The multi-sensor chip contains sensors for temperature, humidity, air quality, and air pressure.

12C address: 0x76

VDD BME VDD BME
U9 I‘
%g SDI VDD 2
SeT SDO VDDIO
SCL 4] ook
2 Nesn ——C40 c41
oND Z TlOOnFTlOOnF
GND o
— BME680 —

Figure 20: Environment sensor schematic

The color sensor onboard Nordic Thingy:91 senses red, green, blue, and infrared light. The sensor faces
towards the blue transparent bottom case with light pipes guiding the light towards the sensor. To
measure the color on a surface, the color sensor is accompanied with an RGB LED that can illuminate
the surface enabling the color sensor to read the color of the reflected light. The color sensor is accessed
through 1’C (slave address 0x38).
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—_— 7 SCL ~————=# SCL  N.C. —— c42
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—  BHI1749NUC —
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Figure 21: Color sensor schematic

6.8 Buzzer

For audio output, Nordic Thingy:91 has a magnetic buzzer. The buzzer is driven by a transistor using a
PWM input.

VDD BZR

BUZZER

Figure 22: Buzzer schematic
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6.9 LEDs and buttons

Nordic Thingy:91 user interface consists of RGB LEDs and two buttons.

6.9.1 RGB LED

Nordic Thingy:91 is equipped with three RGB LEDs.

Two of the LEDs are used to light up the light well and are controlled by the same signals using transistors
as switches. The third LED is located near the color sensor and is used as auxiliary light for color
measurements.
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Figure 23: LED schematic

6.9.2 Buttons
Nordic Thingy:91 has two buttons.

The main button, located underneath the Nordic Semiconductor logo, is termed as the SW3 button and it
is used for user input. It is connected to the nRF9160 SiP. The second button, termed as SW4, is connected
to the nRF52840 SoC. It is accessible only when the rubber cover on the device is removed. Refer the
image Figure 4: Inserting the SIM card on page 11 to locate the buttons.

Either of the two buttons, SW3 or SW4, can be used to activate the serial recovery mode of Nordic
Thingy:91 to update the nRF9160 SiP or the nRF52840 SoC respectively.

For more information, see Programming applications on Nordic Thingy:91 through USB (MCUboot).

6.10 Power supply
The main power source is a rechargeable lithium polymer (Li-Po) battery. The battery has a nominal
capacity of 1400 mAh and can be recharged through USB.

Nordic Thingy:91 has a power switch that physically disconnects the battery and the USB power from the
rest of the circuits. This switch must be on for Nordic Thingy:91 to work and charge the battery. When the
power switch is in the OFF position, it activates a circuit that drains the 1.8 V power domain.

N
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Figure 24: Schematics for battery connector, and the power switch

6.10.1 PMIC

Nordic Thingy:91 uses a power management IC (PMIC) as internal power management. The PMIC includes
a battery charger, a fuel gauge and two regulator outputs.

The PMIC has three voltage domain outputs that are used on Nordic Thingy:91:

e VSYS used for the nRF9160 SiP
¢ One 1.8V output used as GPIO voltage
¢ One 3.3 V output used for analog circuitry

The 1.8 V domain supplies the nRF52840, the accelerometers, the environment sensors, and the GPIOs of
the nRF9160. This domain must always be on for Nordic Thingy:91 to work.

The 3.3 V domain supplies the LEDs, the color sensor, the buzzer, the RF switches and the GPS LNA. This
power domain can be powered down to save power when Nordic Thingy:91 is in sleep mode.
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Figure 25: PMIC schematic

6.10.2 Current measurement

It is possible to measure the current flowing to nRF9160 and nRF52840 by cutting the short on SB3
(nRF9160) and/or SB4 (nRF52840) and placing an ampere meter between the terminals of P1 (nRF9160)
and terminals of P2 (nRF52840).
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Figure 27: Measuring current to the nRF52840
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Figure 28: Current measurement schematic

6.11 Programming and debugging interface

Nordic Thingy:91 is equipped with one programming and debugging interface connector (P8) that is
shared between the nRF9160 and nRF52840.
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The device to be programmed is selected by the SWD SELECT switch (SW2). The selection of device can
also be controlled by connecting TP28 to 1.8 V or ground.
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Figure 29: SWD SELECT switch

The SWD interface of the nRF9160 can also be connected to the nRF52840. The enabling of this
connection is controlled by the nRF52840.
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Figure 30: SWD interface and control schematic

6.12 Interface

To enable the user to connect external hardware, Nordic Thingy:91 routes some of the GPIOs to
connectors or test points and transistors to drive higher currents.

6.12.1 N-MOS transistors

Nordic Thingy:91 is equipped with four N-MOS transistors that can be used to drive small DC motors
or LEDs. The drain and source of the transistors are available on external connectors and the gate is
connected directly to the nRF9160.
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Figure 31: Schematics for the N-MOS transistors

6.12.2 Connectors

In addition to the N-MOS drain and source on P7, power domains and extra GPIOs can be found on
connectors P3-P6.

For more information, see Connector pinouts on page 30.
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Figure 32: Nordic Thingy:91 external connectors

Figure 33: Interface connectors

6.12.2.1 Connector pinouts

1 GND Ground

2 VLi-ion Battery voltage

Table 4: Pinout of connector P3

1 GND Ground

2 1v8 Regulated 1.8 V domain

Table 5: Pinout of connector P4

4418 _1336v1.3 30 .

NORDIC

SEMICONDUCTOR



Hardware description

1 GND Ground

2 3v3 Regulated 3.3 V domain

Table 6: Pinout of connector P5

1 SPARE1 GPIO of the nRF52840
2 SPARE2 GPIO of the nRF52840
3 SPARE3 GPIO of the nRF52840
4 SPARE4 GPIO of the nRF52840
5 SPARES GPIO of the nRF52840
6 SPARE6 GPIO of the nRF52840

Table 7: Pinout of connector P6

1 1v8 Regulated 1.8 V domain

2 GND Ground

3 MOS_1 D Drain of n-channel MOSFET 1
4 MOS_1 S Source of n-channel MOSFET 1
5 MOS_2 D Drain of n-channel MOSFET 2
6 MOS 2 S Source of n-channel MOSFET 2
7 MOS_3 D Drain of n-channel MOSFET 3
8 MOS_3_S Source of n-channel MOSFET 3
9 MOS_4 D Drain of n-channel MOSFET 4
10 MOS_4 S Source of n-channel MOSFET 4

Table 8: Pinout of connector P7

6.12.3 Test points
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Test point  Location Signal Description

TP1 Bottom N.A. Reserved

TP2 Bottom RF_SW1 Bit O of RF switch control signals

TP3 Bottom RF_SW2 Bit 1 of RF switch control signals

TP4 Bottom RF_SW3 Bit 2 of RF switch control signals

TP5 Bottom N.A. Reserved

TP6 Bottom N.A. Reserved

TP7 Bottom nRF91-P0.10 GPIO of the nRF9160

TP8 Top nRF52-P0.18/RESET GPIO/RESET of the nRF52840

TP9 Top SCL 1C clock line

TP10 Top SDA 1C data line

TP11 Top VBUS' USB voltage before power switch

TP12 Top VBUS USB voltage after power switch

TP13 Top Vlii-lon' Battery voltage before power switch

TP14 Top Vli-ion Battery voltage after power switch

TP15 Top GND Ground

TP16 Top GND Ground

TP17 Top VSYS Internal power domain of PMIC and
default nRF9160 power supply

TP18 Top 1v8 Regulated 1.8 V domain

TP19 Top 3V3 Regulated 3.3 V domain

TP20 Bottom ADP_PGOOD1 PMIC output status indication pin 1

TP21 Bottom ADP_PGOOD2 PMIC output status indication pin 2

TP22 Bottom ADP_STP Stop the buck regulator switching of
PMIC

TP23 Bottom ADP_RESET PMIC reset output

TP24 Bottom ADP_MR PMIC manual reset input

TP25 Bottom SPARE7 GPIO of the nRF52840

TP26 Bottom SPARES8 GPIO of the nRF52840

TP27 Top SWDIO Programming interface data line

TP28 Top SWDSEL Programming interface target select

TP29 Top SWDCLK Programming interface clock line

TP30 Top D- USB data line

TP31 Top D+ USB data line

TP32 Top nRF91-P0.13/AINO Analog/digital GPIO of the nRF9160,

combined with N-MOS1

4418_1336v1.3
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TP33 nNRF91-P0.16/AIN3 Analog/digital GPIO of the nRF9160,
combined with N-MOS4

TP34 Top SCK SPI clock line

TP35 Top MOSI SPI master output, slave input data
line

TP36 Top MISO SPI master input, slave output data
line

TP37 Top ADXL372_CS High-G accelerometer chip select line

TP38 Top ADXL362_CS Low-power accelerometer chip select
line

4418_1336v1.3

Table 9: Pinout of connector P3
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/  Regulatory notices

The following regulatory notices apply to Nordic Thingy:91.

7.1 FCC regulatory notices

Modification statement

Nordic Semiconductor ASA has not approved any changes or modifications to this device by the user. Any
changes or modifications could void the user’s authority to operate the equipment.

Interference statement

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including
interference that may cause undesired operation of the device.

Wireless notice

This device complies with FCC radiation exposure limits set forth for an uncontrolled environment and
meets the FCC radio frequency (RF) Exposure Guidelines. This transmitter must not be co-located or
operating in conjunction with any other antenna or transmitter. The antenna should be installed and
operated with minimum distance of 20 cm between the radiator and your body.

FCC Class B digital device notice

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or television reception, which

can be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

e Reorient or relocate the receiving antenna.
¢ Increase the separation between the equipment and receiver.

¢ Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

e Consult the dealer or an experienced radio/TV technician for help.
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Glossary

Development Kit (DK)

A development platform used for application development.

GPIO
General-Purpose Input/Output

Global Positioning System (GPS)

A satellite-based radio navigation system that provides its users with accurate location and time
information over the globe.

Integrated Development Environment (IDE)
A software application that provides facilities for software development.

MCUboot

A secure bootloader for 32-bit microcontroller units, which is independent of hardware and
operating system.

Near Field Communication (NFC)

A standards-based short-range wireless connectivity technology that enables two electronic devices
to establish communication by bringing them close to each other.

Personal Unblocking Key (PUK)

A digit sequence required in 3GPP mobile phones to unlock a SIM that has disabled itself after an in
correct personal identification number has been entered multiple times.

Software Development Kit (SDK)

A set of tools used for developing applications for a specific device or operating system.

SEGGER Embedded Studio (SES)

A cross-platform IDE for embedded C/C++ programming with support for Nordic Semiconductor
devices, produced by SEGGER Microcontroller.

Subscriber Identity Module (SIM)

A card used in User Equipment (UE) containing data for subscriber identification.

System in Package (SiP)
A number of integrated circuits, often from different technologies, enclosed in a single module that
performs as a system or subsystem.

System on Chip (SoC)

A microchip that integrates all the necessary electronic circuits and components of a computer or
other electronic systems on a single integrated circuit.

User Equipment (UE)

Any device used by an end-user to communicate. The UE consists of the Mobile Equipment (ME) and
the Universal Integrated Circuit Card (UICC).
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Universal Integrated Circuit Card (UICC)

A new generation SIM used in UE for ensuring the integrity and security of personal data.

Universal Serial Bus (USB)

An industry standard that establishes specifications for cables and connectors and protocols for
connection, communication, and power supply between computers, peripheral devices, and other
computers.
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Acronyms and abbreviations

These acronyms and abbreviations are used in this document.

DK
Development Kit

GPIO
General-Purpose Input/Output

GPS
Global Positioning System

IDE
Integrated Development Environment

NFC
Near Field Communication

PUK
Personal Unblocking Key

SDK
Software Development Kit

SES
SEGGER Embedded Studio

SIM
Subscriber Identity Module

SiP
System in Package

SoC
System on Chip

usB
Universal Serial Bus

uicc
Universal Integrated Circuit Card
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Legal notices

By using this documentation you agree to our terms and conditions of use. Nordic Semiconductor may
change these terms and conditions at any time without notice.

Liability disclaimer

Nordic Semiconductor ASA reserves the right to make changes without further notice to the product to
improve reliability, function, or design. Nordic Semiconductor ASA does not assume any liability arising out
of the application or use of any product or circuits described herein.

Nordic Semiconductor ASA does not give any representations or warranties, expressed or implied, as to
the accuracy or completeness of such information and shall have no liability for the consequences of use
of such information. If there are any discrepancies, ambiguities or conflicts in Nordic Semiconductor’s
documentation, the Product Specification prevails.

Nordic Semiconductor ASA reserves the right to make corrections, enhancements, and other changes to
this document without notice.

Life support applications

Nordic Semiconductor products are not designed for use in life support appliances, devices, or systems
where malfunction of these products can reasonably be expected to result in personal injury.

Nordic Semiconductor ASA customers using or selling these products for use in such applications do so
at their own risk and agree to fully indemnify Nordic Semiconductor ASA for any damages resulting from
such improper use or sale.

RoHS and REACH statement

Complete hazardous substance reports, material composition reports and latest version of Nordic's REACH
statement can be found on our website www.nordicsemi.com.

Trademarks

All trademarks, service marks, trade names, product names, and logos appearing in this documentation
are the property of their respective owners.

Copyright notice

© 2020 Nordic Semiconductor ASA. All rights are reserved. Reproduction in whole or in part is prohibited
without the prior written permission of the copyright holder.

COMPANY WITH
QUALITY SYSTEM
CERTIFIED BY DNV GL
=1S0 9001 =
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